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 Welcome

Welcome to DrawPlus 3.0 from Serif. It  ’  s the complete drawing, graphics and illustration package for your  
home, school, church or growing business DrawPlus 3.0 can do-it-all-for-you with automated Wizards or 
let you do-it-all-yourself with total control over the powerful drawing features available.
DrawPlus 3.0 is the latest in the DrawPlus line from Serif, developer of the best-selling desktop publisher, 
PagePlus. We’ve added powerful creative and ease-of-use tools, yet still kept the acclaimed simplicity of 
DrawPlus 2.0. And DrawPlus is now a powerful 32-bit application, designed exclusively for Windows 95, 
and ready to handle the most demanding of drawing tasks. It’s everything you need to get started NOW!!

Thank you for purchasing Serif DrawPlus 3.0. Our mission is to make sure that you’ll love it! If you 
have comments of ANY kind please get in touch with us. We need your feedback, especially comments
and suggestions for future versions and companion products.
We also enjoy seeing samples of the work you create with DrawPlus, so please feel free to send them 
in. If you like DrawPlus please recommend it to your friends - your help is always appreciated! Thanks 
to everyone...
If you have any problems (especially with printing), start by checking out the Troubleshooting section of
this help file. If you need technical support or general advice please get in touch. But, please, don’t 
forget to register.
Just Publish It!
P.S.    Late breaking news is available in the README file. And you can watch the Introduction to 
DrawPlus demo too.



About DrawPlus 3.0
From logos, maps and marketing material for business users to fun-stuff like cartoon drawings, masks 
and origami DrawPlus 3.0 does it all. With your PC, printer and DrawPlus you’ve got instant creativity 
with a personalized touch. It’s packed full of Wizards which do everything from creating designer 
publications, logos and page elements to importing pictures, creating colorful fills and creating cool text
effects.

· Total Ease-of-Use
DrawPlus 3.0 makes powerful features available to new users through a slew of ease-of-use 
features designed to zap that learning curve. Specific accelerated learning tools include ToolTips, 
context-sensitive Hints & Tips and multimedia demos.

· Design Wizards
DrawPlus 3.0 is fully-loaded with over 150 Design Wizards – instant designer drawings and 
publications. Just answer the questions and let the Design Wizards do the work! There’s Design 
Wizards for all kinds of business and home-based tasks.

· Logo Wizard
Logo Wizard makes it simple to add stunning logos, powerful headlines and eye-popping text 
effects to a drawing. Input the text, choose a design and DrawPlus 3.0 drops a typographic bomb!

· Background Wizard
Adding abstract or themed backgrounds is easy with Background Wizard. From dazzling 
presentation backgrounds to space style scenes, Background Wizard gives your drawing a ready-
made designer canvas.

· Watermark Wizard
Watermark Wizard makes a notoriously difficult effect a snap to create with a wide range of 
customisable watermark designs on hand.

· Border Wizard
Vastly flexible Border Wizard instantly adds borders to the page or to individual objects. Choose a
border from the extensive library, or be creative and let Border Wizard guide you through building 
a unique design.

· QuickShapes
Can’t draw? Won’t Draw? QuickShapes are the answer! They work like intelligent clipart… or the 
most powerful set of drawing tools you’ve ever envisaged. Even extremely complex shapes like 
spirals, petals and webs are simple to draw and customize using QuickShapes.

· Professional-Standard Drawing Features
Features like convert text to curves, user-defined envelopes, automatic shadows, layers and 
multi-color fills give complete creative power. OLE2 compliance makes DrawPlus integrate 
perfectly with other Windows 95 applications.

· Fun Stuff
As drawing and graphics appeals to all those creative types… and to make DrawPlus the only 
real drawing application to let your kids loose on there’s heaps of fun stuff included. Create 
fearsome fiends with the Monster Maker Wizard; crazy caricatures with the Crazy Face Wizard; 
and use Design Wizards for making cool games, masks, planes, origami and scenes.

With a combination of functionality, simplicity and low price point, addressing the everyday needs of 
individuals and growing businesses, DrawPlus 3.0 is the drawing, graphics and illustration program for 
everyone



Our Products

We aim to satisfy all your drawing, graphics and desktop publishing needs with a range of low cost 
products:

· DrawPlus 3.0 A stunning vector drawing and illustration program (like CorelDRAW!) exclusively 
for Windows 95. It’s the perfect design partner for you and PagePlus, and the easiest way to 
draw like a pro!

· PagePlus 4.0
An award winning desktop publisher exclusively for Windows 95, with an unrivaled combination of
powerful features and simplicity.

· PagePlus Home/Office Edition
Our entry level desktop publisher exclusively for Windows 95. It’s the easiest desktop publisher, 
ever. 

· Publishing Power-Suite
For Windows 3.1 users (Windows 95 compatible) the Publishing Power Suite contains everything 
you need to produce great results. Contains PagePlus 3.0, DrawPlus 2.0, PhotoPlus, TypePlus, 
TablePlus, PhotoMorph, Arena3D and a library of fonts, clipart and photos. It’s the DTP kitchen 
sink!

· Multi-User Licenses All our products are networkable, and are ideal for multi-user configurations
in schools, colleges, government and corporate departments. Our low-cost Site Licenses make 
Serif products especially popular. Call for details.



Our Mission

DrawPlus is a best-selling, award-winning drawing, graphics and illustration program. And our new 
DrawPlus 3.0 is the easiest and most powerful. Serif is dedicated to giving you the chance to own and 
use great software.



Serif contact details

If you have comments, questions or problems please get in touch with us:

Our main office (USA, Canada):
Serif, Inc.
PO Box 803, Nashua NH 03061 USA
Main (603) 889-8650
Registration (800) 697-3743
Sales (800) 489-6719
Technical Support (603) 886-6642
Customer Service (800) 489-6720
Fax (603) 889-1127

European office (UK, Europe):
Serif (Europe) Limited
PO Box 15, Nottingham NG7 2DA UK
Main (0115) 9421502
Registration (0500) 454645
Sales (0800) 924925 
Technical Support (0115) 9421502
Customer Service (0115) 9421502
Fax (0115) 9701022

On-line
Internet home page http://www.serif.com/
e-mail serif@serif.com, register@serif.com, support@serif.com
CompuServe forum GO PAGEPLUS

International
Please contact your local Serif distributor/dealer. For further details please call us.



Credits

· Clipart samples from Serif ArtPacks © Serif, Inc. & Paul Harris
· Portions Clipart © 1996 IMSI. All rights reserved.
· TrueType font samples from Serif FontPacks © Serif, Inc. 
· Portions graphics import/export technology ©    AccuSoft Corp. & Eastman Kodak Company & 

INSO Corporation.
· ImageStream® Graphics and Presentation Filters, Copyright © 1991-1996 INSO Corporation. All 

Rights Reserved.
· Portions electronic demonstrations developed using Astound and contains proprietary software of

Gold Disk Inc.

All Serif product names are trademarks of Serif, Inc. Microsoft, Windows 95, and the Windows logo are
registered trademarks of Microsoft Corporation. All other trademarks acknowledged.
Serif DrawPlus 3.0 © 1996 Serif, Inc.
Many thanks to many DrawPlus users for supporting us… Especially our international user panel, 
dedicated beta testers, local pizza delivery, and everyone else who took the time to make comments 
and suggestions to help us. We couldn’t do it without you. And, of course, a big thank you to Barry 
Cinnamon the “big boss”. We love you, Barry… 



 Menus
This topic shows the DrawPlus menus and gives a brief description of each entry. Many of these 
entries have shortcut buttons on the Standard Toolbar or are also available in a “pop-up” menu when 
you right-click on an object.
Click on the menus to find out more...



File Menus

· File/New displays the StartUp Wizard which allows you to select from various options before 
starting a new drawing.

· File/Open... displays a standard Windows dialog which allows you to open an existing DrawPlus 
(*.DPP files) drawing.

· File/Close closes the current file and opens a new drawing. This is the same as choosing Start 
from Scratch from the Startup Wizard.

· File/Save saves the current drawing. (If it is unsaved - then this will do a File/Save As...)

· File/Save As... displays a dialog for you to enter a file name for this drawing.

· File/Properties displays a dialog for you to enter additional details about your drawing.

· File/Page Setup... displays a dialog allowing you to set up the page for your drawing.

· File/Print Preview displays a preview of how your document will look when it is printed. 

· File/Print... displays a dialog box providing options for selecting which printer to print your 
drawing to and how to print it. The Options button allows you to set scaling, tiling and other useful 
features.

· Export as Picture... exports all the objects in your drawing, or alternatively just the current 
selection, as a picture in a variety of file formats.

· File/Send... lets you send the current drawing as a Microsoft Mail e-mail message.

· Last Saved Files List is the list of your most recently drawings. Select the one that you want to 
change.

· File/Exit closes DrawPlus.



File
Commands for opening, saving
and printing publications...
New
Open…
Close
Save
Save As...
Properties
Page Setup...
Print Preview
Print...
Export as Picture..
Send...
Last Saved Files List
Exit



Edit
Commands for clipboard
(cut & paste) and OLE.
Undo
Redo
Cut
Copy
Paste
Paste Special…
Clear
Select All
Links…
Text…
Object



Edit Menu

· Edit/Undo undoes the most recent change to the current drawing. Undo is grayed out when not 
available.

· Edit/Redo reapplies a change which has just been undone

· Edit/Cut deletes the selected object or group of objects from the drawing AND places a copy on 
to the Windows clipboard.

· Edit/Copy copies the selected object, or group of objects, to the Windows clipboard.

· Edit/Paste pastes a copy of the contents of the Windows clipboard on to the current drawing.

· Edit/Paste Special... The Windows clipboard can contain different formats of the same object 
(e.g. Picture, Bitmap, OLE). This option allows you to specify which format is used.

· Edit/Clear clears (deletes) the selected object or group of objects.

 Edit/Select All selects all the objects in the current drawing as a group.

· Edit/Links... controls your OLE links.

· Edit/Text... Opens the Edit Text Window, allowing you to edit the currently selected text object.

· Edit/Object is the standard OLE Object menu command. (It changes according to the type of the 
selected object.)



View 
Commands for setting
view and zoom options...

Fit Page
Actual Size
Selection
Wireframe
Toolbars…
Layout Tools  >  
Zoom In
Zoom Out
Zoom…



View Menus

· View/Fit Page> sets the view so that the entire page is displayed on screen. 

· View/Actual Size displays the currently selected object at its actual size (the size it will appear 
when printed).

· View/Selection sets the view to display the currently selected object.

· View/Wireframe displays the objects on the page as outlines.

· View/Toolbars allows you to control which Toolbars are displayed.

· View/Layout Tools> allows you to toggle on/off the display of rulers, guides and the snapping 
grid.

· View/Zoom In increases the current zoom percentage (makes objects appear larger).

· View/Zoom Out decreases the current zoom percentage (lets you see more of the page).

· View/Zoom... displays a dialog allowing you to set zoom options.



Insert
Commands for working
with objects, pictures etc. 

Object...
Picture Wizard
Logo Wizard
Monster Wizard
Crazy Face Wizard
Background Wizard
Watermark Wizard
Border Wizard
PageHint      



Insert Menu

· Insert/Object displays the standard dialog allowing you to insert any type of OLE object.

· Insert/Picture Wizard displays the Picture Wizard, allowing you to import pictures from a variety 
of sources.

· Insert/Logo Wizard Logo Wizard makes it simple to add stunning logos, powerful headlines and 
eye-popping text effects to a drawing. Input the text, choose a design and DrawPlus 3.0 drops a 
typographic bomb!

· Insert/Monster Wizard loads the Monster Maker Wizard, adding a wacky Monster design to your
drawing.

· Insert/Crazy Face Wizard starts the Crazy Face Wizard, adding a Crazy Face design to your 
drawing.

· Insert/Background Wizard Adding abstract or themed backgrounds is easy with Background 
Wizard. From dazzling presentation backgrounds to space style scenes, Background Wizard 
gives your drawing a ready-made designer canvas.

· Insert/Watermark Wizard Watermark Wizard makes a notoriously difficult effect a snap to create 
with a wide range of customisable watermark designs on hand.

· Insert/Border Wizard Vastly flexible Border Wizard instantly adds borders to the page or to 
individual objects. Choose a border from the extensive library, or be creative and let Border 
Wizard guide you through building a unique design.

· Insert/PageHint... inserts a PageHint into your publication to act as a reminder or helpful 
comment.



Format
Commands for changing formatting
of text and graphics, 
Character...
Spacing      
Fill     

Existing  >  
Shading  >  

Fill Wizard
Fill Manager...
Line ...
Weight  >  
    Color  >  
    Shading  >  
    Type  >  
Shadow...



Format Menu

· Format/Character... displays a dialog containing text properties such as font, point size, and font 
style.

· Format/Spacing… displays a dialog containg text spacing properties such spacing, leading and 
tracking.

· Format/Fill… displays a dialog allowing you access to entire range of fill options.

· Format/Fill(Existing)> displays a list of existing fills in an easy access side-pull menu.

· Format/Fill(Shading) > displays list of predefined shades, in an easy access side-pull menu.

· Format/Fill Wizard displays the Fill Wizard, helping you to apply existing fills or create amazing 
new ones.

· Format/Fill Manager… displays the Fill Manager, giving you complete control over your fills.

· Format/Line… displays a dialog allowing you access to entire range of line options.

· Format/Line(Weight)> displays a list of predefined Line Weights in an easy access side-pull 
menu.

· Format/Line(Color)> displays list of predefined Line Color in an easy access side-pull menu.

· Format/Line(Shading)> displays list of Line Shades in an easy access side-pull menu.

· Format/Line(Type)> displays list of Line Types in an easy access side-pull menu.

· Format/Shadow... is a dialog for editing and managing Shadows.



Tools
General program tools
and options..

Replicate Wizard 
Transform Wizard
Convert to Bitmap…
Photo Wizard
Convert to Curves
Clean Curves
Join Curves
Envelope Wizard
Curve Text Wizard
Blend...
Defaults...
Options...
Save Settings...



Tools Menu

· Tools/Replicate Wizard displays the Replicate Wizard, providing you with a quick way to make 
many identical copies of the currently selected object.

· Tools/Transform Wizard ... displays the Transform Wizard allowing you to transform the 
currently selected object, creating amazing special effects. 

· Tools/Convert to Bitmap...converts your currently selected object(s) to a bitmap.

· Tools/Photo Wizard... runs Photo Wizard, giving you access to a range of special bitmap effects.

· Tools/Convert to Curves converts the currently selected object to curves, giving you a greater 
range of editing options. 

· Tools/Clean Curves smooths the curves of the currently selected object, making display faster 
and editing easier.

· Tools/Join Curves use this command to join together the curves of objects that you have 
selected.

· Tools/Envelope Wizard displays the Envelope Wizard, giving you instant access to great special
envelope effects.

· Tools/Curve Text Wizard amazing text effects are easy    just use this Wizard.

· Tools/Blend… creates amazing morphing effects, blending your selected objects together.

· Tools/Defaults... allows you personalize your DrawPlus text and graphics defaults.

· Tools/Options... displays a dialog with giving you complete control over your DrawPlus 
preferences.

· Tools/Save Settings... makes your personal changes permanent.



Arrange
Help, Hints, Tips and options
for learning DrawPlus.

Align Items ...
Size Items...
Flip  >  
Rotate  >  
Order Objects  >  
Layers  >  
Group
Combine
Lock Position
Unlock Position
Snapping



Arrange Menu

· Arrange/Align Items... allows you to align the objects in a group relative to one another.

· Arrange/Size Items... allows you to make all selected objects the same size as the last object 
selected.

· Arrange/Flip> flips your selection vertically, horizontally or both.

· Arrange/Rotate> rotate your object to one of the predefined values, or specify an exact rotation 
angle by choosing Custom.

· Arrange/Order Objects> allows you to quickly and easily move objects between layers.

· Arrange/Layers> gives you complete control over the layers within your drawing.

· Arrange/Group Converts your currently selected objects to a permanent group.

· Arrange/Combine Combines the outlines of objects from the current selection. If two or more 
objects are selected, Combine produces a more complex shape with a single interior and "holes" 
where they overlap.

· Arrange/Lock Position... locks your selection at it’s current position.

· Arrange/Unlock Position... reverses the above.

· Arrange/Snapping if checked, snapping is currently switched on. Select this to toggle the current
snapping status between on and off..



Help

Help, Hints, Tips and options
for learning DrawPlus.

DrawPlus Help Topics
Watch a Demo
Play Game
Registration Wizard
Credits
About DrawPlus...



Help Menu

· Help/DrawPlus Help Topics displays the Help Contents page.

· Help/Watch a Demo… lets you watch the demos. (Or, use the Startup Wizard.)

· Help/Play Game… lets you play the free game (if you’re registered).

· Help/Registration Wizard... helps you to register your own personal copy of DrawPlus.

· Help/Credits shows copyrights.

· Help/About DrawPlus displays the DrawPlus opening image.



 Printing
Printing is the final step in the creation of your drawing. Make sure that you have the desired printer 
setup (File/Print/Properties...), that your printer is ready, then print.
Take a look at Common printing problems if you have any problems.



 Support and troubleshooting
Our support mission is to provide fast, friendly technical advice and support from a team of on-call 
experts. Registration gives you access to regular Serif newsletters and low cost future upgrades.
All Serif products are extensively tested before release, and we are totally confident in their quality and 
rock-solid stability. However, it is impossible to test all available hardware, and sometimes there are 
unexpected hardware/software incompatibilites. The only way to resolve these kinds of issues is to 
“troubleshoot” your system to find the cause of the problem.
Some of the most common problems are easy to solve. Check these topics out first for guidance:

· Common printing problems
· Non-printer problems
· System setup troubleshooting

You should also read the README file which covers late breaking news, and may include problems 
discovered too late to be discussed here.

Getting support
If you need help, then just get in touch. We will do our best to help.



Common printing problems

Printing problems can be caused by a number of things such as using an incorrect or out of date 
printer driver, or having the wrong options set for your printer. Some of the more common faults are 
listed here with suggestions for fixing the problem.

Problem
A Windows Error or a DrawPlus Error is displayed while printing from DrawPlus.
See the Windows printer driver problems topic.

Problem
The printed output produced by DrawPlus is unreadable or bears no resemblance to the document on 
screen.
See the Windows printer driver problems topic.

Problem
When I print documents with an object that goes right to the edge of the page, not all of the object gets 
printed.
Virtually all printers have non-printing margins, and any item that falls into this area will not be printed. 
This means that on most printers you cannot produce a “bleed” as this is know. If you use a smaller 
publication page size, than the paper size in your printer, then this is not a problem. This is also not a 
problem with PostScript output to an imagesetter, where the full page size can be imaged.



Windows printer driver problems

Printing problems with Windows 95 are generally caused by using an incorrect or out of date Windows 
3.1 printer driver, or a third-party printer driver. Make sure that you use the Windows printer driver 
designed specifically for your printer.
Windows Help has extensive troubleshooting information. Use Start > Help/Troubleshooting

Checking your printer driver version
If you have upgraded from Windows 3.1 to Windows 95 you must check that you are now using the 
latest Windows 95 driver for your printer.

To add printer drivers use Start > Settings > Printers



Non-printer problems

The are currently no reported problems.



System Setup Troubleshooting

The Windows 95 operating environment is a technically complicated system and problems can occur if 
your PC is not setup correctly or is using old (Windows 3.1) or non-standard device drivers etc.
If you understand terms such as config.sys and autoexec.bat then you may be able to resolve system 
setup problems by following the guidelines below. If you don't understand these terms then you should 
contact Microsoft technical support if you think your problem is related to Windows, or Serif technical 
support if you think that your problem is specific to a Serif product and not related to Windows.

Troubleshooting
In brief, the idea is to simplify your PC's setup, see if the problem is no longer present, and then 
incrementally restore your PC's original setup, testing to see which component makes the problem re-
occur. Be careful!
Windows Help has extensive troubleshooting information. Use Start > Help/Troubleshooting



 Tour of the Screens
Click on the following screens to find out what the various elements are called, and how to use them. 
You can choose:
· DrawPlus with blank page
· DrawPlus with drawing
· Edit Text
· Photo Wizard

You can also look at demos using Help/Demos... to get more information about how DrawPlus, Edit 
Text and PhotoWizard work.



 DrawPlus Screen
This is the main DrawPlus working screen, where you will design and create your drawings.
Click on the buttons, tools, and other elements to find out more...



Title Bar
This is the standard Windows Title Bar showing the name
of the program and the current file (e.g. Design1 or “Drawing”
if it has not been saved). The Windows buttons at the right side
of the title bar let you minimize, mazimize or close the application.



Menu Bar
These are the program menus, where you can
select various commands. You can access similar menus
that pop-up by right-clicking on an object.



Standard Toolbar
The Standard Toolbar contains shortcut buttons, for performing a variety of 
functions. Some of the buttons are always available, while others only become
enabled when an object is selected. Experiment by selecting an object and 
watching how the Standard Toolbar changes.



Scroll Bars
A standard Windows control for changing the area
of your page that is visible.



Fill Bar
The Fill Bar allows you to apply a fill/shade
to an object. The shade is a tint of the fill
between 10% (faint) to 100% (solid fill). The
object’s current fill and shade is highlighted.



Status Bar
The Status Bar contains buttons for adjusting the current view
and showing/hiding the Status Bar floating palettes. The right
side is the HintLine which displays useful information.



QuickShape Flyout
QuickShapes are pre-designed objects, provided by DrawPlus to save you time.
The QuickShape flyout contains a wide variety of commonly used shapes, including boxes, ovals, 
arrows, polygons and stars. To create a QuickShape, select a shape from the flyout and than drag over
the page. The QuickShape fills the area you drag. When you release the mouse button, the 
QuickShape tool reverts to the Node tool, ready for the shape to be altered by dragging on its handles.



Status Editor Palette
The Status Editor is a floating palette
which allows you to specify exact size, position
and rotation values.The Status Editor can be
used to “nudge” the object position by using the
spin buttons. Or type in new values for the object
size and position.



Tool Bar
The Tool Bar provides the main DrawPlus Tools for
creating and editing objects. The Pointer group of pointer,
rotate and node editing. The Create group for creating text, lines, curves 
and QuickShapes The Import group for adding clipart, and other embellishments for text to your 
drawing.



DrawPlus Tool Bar

This topic shows the DrawPlus Tool Bar and gives a brief description of the tools and how to use them. 
Notice how the current Tool is highlighted.
Click on the tools to find out more...



Tool Bar Pointer Tools
Click on the  Selection Tool to select, move and copy objects.
To select, click on the object.
To resize the selected object, drag over its handles.
To move the selected object, drag on it.
To copy the selected object, drag on it holding the control key.
To add the selected object to a group, click on it holding the shift key.
Click on the Rotate Tool to rotate objects at any angle. First, select
the object, then drag over one of the handles. Hold the shift key for
15 degree steps. Double-click to unrotate.
With the Node Tool you can manipulate the shape of objects by dragging on the object's control 
nodes. The Node Tool can also select and move objects, in the same way as the Selection Tool. 
Objects must be selected before the Node Tool can manipulate them. The currently selected object is 
shown displaying control nodes.



Text Tool
Use the Text Tool to add text to your drawing. Click with the Text Tool on the page and type to add text. 
Click and drag to set the size of the text before you type or double-click to open the Edit Text  dialog.



Tool Bar Create Tools
Click on the each of the following to find out more about it’s capabilities
Line Tool Flyout
QuickShape Flyout 
Text Tool 



Line Tool Flyout
Freehand line tool
This tool can be used to sketch lines in a freeform way. Select the tool, move the mouse over the page 
area and drag to draw. The curve will follow your mouse movements. When you release the mouse 
button the Freehand line tool will automatically smooth out the line and insert a minimal number of 
corner nodes.
If you want to extend an existing line, start your drag at an end point of an existing line.
If snapping is switched on, the Freehand line tool produces horizontal, vertical and diagonal straight 
line segments as opposed to a mixture of curved and straight line segments. A line in DrawPlus is 
made of a number of line segments joined together by corner nodes. If the line forms a complete 
outline, then it is known as a closed shape. Once you've drawn a line or closed shape, you can 
reshape it by dragging the corner nodes with the Node tool.

Use the Straight Line tool to create straight line segments. Select the tool and drag on the page. A 
straight line between the points where the drag started and ended is created. If you want to extend an 
existing line, start your drag at one of the existing line's end points.
Hold the SHIFT key down while dragging to constrain the angle of the created line to 15 degree 
increments. This is an easy way to make exactly vertical or horizontal lines.

Use the Curved line tool to draw a mixture of large, sweeping curves and straight line segments. This 
tool is unlike the others, in that the drawing happens between mouse clicks rather than when the 
mouse is being dragged.
To start drawing, click on the page where you want the line to start. If you want to extend an existing 
line, start the line at an existing line's end point. Now every following mouse click will add another line 
segment. If you want the segment to be curved, hold the mouse down while you click and drag out an 
attractor node. Attractor nodes act as magnets, pulling the curve into shape. If you want the segment to
be straight, just click without dragging.



Tool Bar Import Tools
Click on Import to run the Import Picture Wizard, allowing you to quickly and easily import pictures 
from a variety of sources. Simply follow the on-screen instructions, and when the import picture cursor 
appears, click and drag to place your selected picture on the page.
Hold the shift key down if you want to maintain aspect ratio.
Click on the Wizard Flyout, then select one of the six Wizard buttons. When you have followed the on-
screen instructions and answered the Wizard questions, drag out the object on your page. 



Page
The page is the piece of paper that you’re working on. This page
shows the margins and three ruler guides. Place your guides, 
text, graphics and pictures here 
to create your masterpiece 



Pasteboard
This is the “scratch” area around your page where
you can place objects until you need them on the page.
The pasteboard does not get printed.



Rulers
The rulers allow you to measure your page
and objects. A selected object is shown by white
indents on the rulers. Drag on the intersection to
move them. Click on the rulers to create guides.



 DrawPlus Screen with Page
This screen shows what DrawPlus looks like with a real page.
Click on the screen elements, and the objects on the page, for more information.



Border
This is a fancy border, which is easily applied by running the Border Wizard.



Text Headline
This is part of the headline typed in the Edit Text Window and then 
a fancy fill applied with the Fill Wizard.



Pop-Up Menu
Right-click on an object to get a pop-up menu. This
one contains general options available when no object is selected.



Clipart Browser
This makes the huge DrawPlus clipart selection instantly accessible, 
simply select the picture you’d like and drag and drop onto your drawing



Curve Editor
The Curve Editor works in combination with the Node tool. Select the corner node or point on the line 
or closed shape which is to be affected by the Curve Editor and then use the buttons on the Curve 
Editor. If all the Curve Editor's buttons are grayed out, you need to select a part of the line or shape to 
work on.



Picture 
This is a a picture imported using the Import Picture Wizard. Use the Fill Wizard
to give it a fancy look, or try the Watermark Wizard to give your drawing a classy feel.
Alternatively, convert it to a bitmap using Tools/Convert to Bitmapand experiment with the amazing 
effects available in Photo Wizard



Formatting Bar
This Microsoft Office Compatible feature enables you to apply a wide range of formatting options to 
your selected object. With text selected, the options include bold, italic font and point size, with a 
graphic selected, line weight and style.



 Edit Text
The Edit Text Window is DrawPlus’s built-in text editor. Use it to create new text, or edit existing text. 
Start Edit Text by double-clicking on the page with the Text tool, by double clicking on an existing piece 
of text, or by selcting a piece of text and choosing Edit/Text… from the menu. 
Click on the buttons and other elements to find out more...



Edit Text Tool Bar
The Tool Bar provides edit/clipboard shortcuts, and text
formatting commands such as bold, italic and point size.



Entering Text with Edit Text
Edit Text is designed for fast text editing and creation using
standard Windows cursoring controls for moving through the
text. If you're familiar with using Windows accessories like
WordPad you'll immediately be familiar with Edit Text.



 Photo Wizard
This is the main Photo Wizard working screen: the bitmap editing module built into DrawPlus. Use it to 
convert your files between apply special effects to your bitmaps, to touch up photos before updating 
your work back into DrawPlus. If you want to see Photo Wizard in action, you can take a look at the 
helpful demos using Help/Watch a Demo... 



Photo Wizard Title Bar
This displays the current DrawPlus drawing title, and the
Windows controls for minimizing, maximizing and closing the
window. The PhotoWizard window can be resized and moved like
any normal window to suit your method of working.



Photo Wizard Preview Window
The Preview Window shows your current picture.
The mouse cursor changes to a magnifying glass when it is over this window, to show that zoom is 
available. To magnify the view of a particular area, drag the Zoom cursor over the area.
To reset the zoom to Fit Window, which means the picture is automatically scaled to fit the Preview 
Window, hold the SHIFT key down and click. To reset the zoom to 1:1, which means one picture pixel 
equates to one screen pixel, double-click.

You can also change zooms by using the row of Zoom buttons in the Front Panel. The current zoom 
percentage is displayed in the Status bar.
If you have the Crop tool selected, the mouse cursor will change to the crop symbol and dragging over 
the Preview Window will crop the picture to the area you drag.



Photo Wizard Status Bar
The Status Bar shows information about the current picture. The information includes:

The width and height of the picture in pixels.
The picture's color depth, which is the number of bits used to store the color of each pixel. This 
determines the maximum number of different colors the picture can have, which is also displayed.
The amount of memory the picture takes up, in kilobytes when uncompressed.
The current zoom percentage for the Preview Window.



Photo Wizard Front Panel 
The Photo Wizard Front Panel gives you access to the full range
of special effects and image controls available in Photo Wizard.

The top set of buttons allows you to apply one of the special, 
predefined filters to your picture, these include sharpen, smooth,
emboss, posterize and sepia.

The second group of controls manipulate color. You can change
the red, green and blue color components and adjust brightness
and contrast. You can perform gamma correction and dither 24-bit
TrueColor pictures down to, say 8-bit, 256 colors.

The controls in the third group perform geometric operations.
You can mirror the picture, rotate it by 90° or by any other angle. 
You can scale the picture to fit an exact size and crop it to remove 
unwanted detail.

The next line of controls support the clipboard: You can cut, copy 
and paste to and from the clipboard and undo changes.

The bottom group of controls manage the Preview Windows Zoom
percentage.



 On-line Book
This Windows Help file provides information about DrawPlus 3.0. Browse through it using the usual 
Windows Help controls. And you can take a look at the helpful demos using Help/Watch a Demo... for 
even more information about DrawPlus.
You can also read DrawPlus documentation on screen! It has been converted to an Adobe Acrobat file 
with hyperlinked Contents and Index pages. You’ll find that Acrobat provides easy tools for viewing and
navigating the publication.

Click here  to read DrawPlus 3.0 Companion.
(You need to install Adobe Acrobat to use this feature.)

Click here  to read the latest news in the DrawPlus README file.



Demos

Access demos using Help/Demos... or by selecting the “Watch a Demo” option in the Startup Wizard. 
The following demos are available:
(Be patient, loading the demo takes a few moments.)
· Click here  to watch Introduction.

· Click here  to watch Photo Wizard. 

· Click here  to watch Wizard Design Elements. 

· Click here  to watch QuickShapes. 



 Registration
As a Registered User we can keep you informed about upgrades and other products.
The Serif Registration Wizard guides you through the process of registering your copy of DrawPlus 3.0.
Registration is simple and FREE, but you do need to register within 90 days of installing your copy.
To register you need to enter your Registration Number. If you bought directly from Serif, this number is
printed on your invoice. If you obtained DrawPlus from a store or dealer, or it was bundled with a PC, 
scanner or printer you will need to call Serif (free phone call) and quote your Installation Number and 
Code to get it. Either way, it's quick, simple and free. If you've not registered yet, this screen will pop-up
regularly to remind you.



How To...
Get Help

Start, Save and Close Drawings.

Add Text

 Add Logos and Text Effects.

Import Pictures

Add Backgrounds and Watermarks

Select, Copy, Move, and Resize

Rotate and Shear

Arrange Objects

Format Objects

Print your Drawing

Create new Fills

Customize DrawPlus



Get Help
Help
Use the Help file (Help/DrawPlus Help Topics)  in the usual way to get more information about using 
DrawPlus.

Hints and Tips
Hold your mouse over a button for a pop-up ToolTip. Watch out for the helpful Hints and Tips that pop-
up as you work. They can be disabled or reset using Tools/Options.

Demos
Take a look at the interactive demos for more help on DrawPlus.

Online Companion
The Online Companion is full electronic documentation for you to browse through.



Start, Save and Close Drawings
Start a new Drawing
Use File/New to get the Startup Wizard, then choose the Start from Scratch option.

Open an existing Drawing
Use File/New to get the Startup Wizard, then choose the Open a Drawing option or choose File/Open 
to go directly to the dialog box. The file menu also lists your last used publications. Click on the name 
to load the file.

Use a Design Wizard
Choose the Use a Design Wizard option from the Startup Wizard to have DrawPlus create a 
publication or drawing for you. Then simply answer the on-screen questions and add your own 
information.

Save your Drawing
Use File/Save or File/Save As to save your Drawing.

Close DrawPlus
To close DrawPlus choose File/Exit



Add Text

Add new Text
Use the Text Tool to add text to your drawing. Click with the Text Tool on the page and type to add text. 
Click and drag to set the size of the text before you type or double-click to open the Edit Text dialog.

Edit existing Text
Double-click on the text with the Selection Tool, double-click on the text with the Text Tool or single-
click on the text with the Text Tool to open the Edit Text dialog with the text loaded. Use the Edit Text 
dialog to edit the text or apply formatting.

Text on a Curve
Make sure the Curve Text Wizard is turned on using Tools/Options/Ease of Use then use Tools/Curve 
Text Wizard to access the Curve Text Wizard. Follow the on-screen questions and enter your own 
information. Alternatively, select some text on the page with the Selection Tool and use the Curve Text 
flyout on the Standard Toolbar to apply a predefined curve.

Enveloped Text
Make sure the Envelope Text Wizard is turned on using Tools/Options/Ease of Use then use 
Tools/Envelope Wizard to access the Envelope Wizard. Follow the on-screen questions and enter your 
own information. Alternatively, select some text on the page with the Selection Tool and use the 
Envelope flyout on the Toolbar to apply a predefined envelope shape.

Fancy text with Logo Wizard
Use Insert/Logo Wizard or the Logo Wizard button on the Wizard flyout to access the Logo Wizard. 
Answer the on-screen questions and input your own information.



Add Logos and Text Effects
Fancy text with Logo Wizard
Use Insert/Logo Wizard or the Logo Wizard button on the Wizard flyout to access the Logo Wizard. 
Answer the on-screen questions and input your own information.

Text on a Curve
Make sure the Curve Text Wizard is turned on using Tools/Options/Ease of Use then use Tools/Curve 
Text Wizard to access the Curve Text Wizard. Follow the on-screen questions and enter your own 
information. Alternatively, select some text on the page with the Selection Tool and use the Curve Text 
flyout on the Standard Toolbar to apply a predefined curve.

Enveloped Text
Make sure the Envelope Text Wizard is turned on using Tools/Options/Ease of Use then use 
Tools/Envelope Wizard to access the Envelope Wizard. Follow the on-screen questions and enter your 
own information. Alternatively, select some text on the page with the Selection Tool and use the 
Envelope flyout on the Standard Toolbar to apply a predefined envelope shape.

Shadows on Text
Select a text object using the Selection Tool then use Format/Shadow… to customize and add a 
shadow effect or use the Shadow button on the Standard Toolbar to add the last used shadow.



Import Pictures
Import Picture Wizard

Click on the Import Picture button on the Drawing Toolbar to access the Import Picture Wizard or select
Insert/Picture Wizard  from the menus. Make sure the Import Picture Wizard is turned on by using 
Tools/Options/Ease of Use. This will help you choose and import your picture.

DrawPlus 3.0
The Import Picture Wizard allows you to choose picture using the Serif DrawPlus 3.0. You can view 
pictures then drag and drop them onto your drawing.

Scanning
The Import Picture Wizard allows you to scan directly into DrawPlus using the TWAIN scanning 
standard.

PhotoCD Images
This option allows you to view and import pictures from a PhotoCD



Add Backgrounds and Watermarks
Background Wizard
Use Insert/Background Wizard or the Background Wizard button on the Wizard flyout to access the 
Background Wizard. Answer the on-screen questions and input your own information.

Watermark Wizard
Use Insert/Watermark Wizard or the Watermark Wizard button on the Wizard flyout to access the 
Watermark Wizard. Answer the on-screen questions and input your own information.



Select Copy Move and Resize
Select an Object
Use the Selection Tool to select an object by clicking on it. Step through overlapping objects by clicking
repeatedly. You must select an object before you can modify it.

Select a Group
Hold down the Shift key while clicking to add an object to a group. Or, using the Selection Tool, start 
dragging over a blank area of your drawing to create a selection box or “marquee”. Any objects 
enclosed in this box will be selected as a group.

Copy
Use the Selection Tool to drag on an object while holding down the Control key.

Move
Use the Selection Tool to drag on a selected object.

Move, exact value
Use the Status Editor to enter exact position values.

Resize
Use the Selection Tool to drag over one of the handles on a selected object.

Resize, exact value
Use the Status Editor to enter exact size values.



Rotate and Shear
Rotate
Use the Rotate Tool to drag over one of the corner handles of a selected object.

Rotate, exact value
Use the Status Editor to enter exact rotation angle values.

Shear
Use the Rotate Tool to drag over the middle handles of a selected object.



Arrange Objects
Align Objects
Objects can be aligned in relation to each other by selecting them as a group, then using Arrange/Align
Items.

Snapping
Objects can be lined up with any guides (margins, ruler guides, grid dots) that are visible on your page 
when then Snapping button on the Status Bar is checked.

Order Objects
As objects are created they are order is such a way that the most recently created object will overlap 
earlier ones. You can change the order of and object within the stack by stack by selecting it then using
Arrange/Order Objects.

Layering
The DrawPlus page can have multiple layers to contain different sets of objects. Use 
Arrange/Layer/Layer Manager to add or delete layers or to control how DrawPlus uses layers. Use the 
Layer Tabs above the Status Bar to access different layers. 

Permanent Groups
Groups of objects can be made permanent by using the Group/Ungroup button on the Standard 
Toolbar.



Format Objects
Use Menus
Use the Format menu to change how objects look.

Use the Formatting Toolbar
Use the options on the Formatting Toolbar to change how objects look.

Use the Fill Bar
Click on the Fill Bar to apply a fill to selected object. The right-click menu has options for adding 
separate fills and line colors for objects.

Use Right-Click Menus
Right-click will always pop-up a menu with options appropriate for the selected object. Right-click on 
the selected object and choose a pop-up menu option to change how the object looks. 
Use Paste Format
Select an object with the formatting you want to apply to another object. Click the Paste Format button 
on the Standard Toolbar. The next object you select with have the formatting of the original object 
applied to it. Use Shift-Click to select object without pasting the new format.



Print your Drawing
Print
Use File/Print to print your masterpiece! Set the Options you want to reduce the drawing to fit onto your
printer page or to create giant, tiled posters.

Print Preview
Use File/Print Preview or click on the Print Preview button on the Standard Toolbar to get a quick 
preview of how your drawing will print.



Create new Fills
Use Fill Wizard
Use Format/Fill Wizard to let the Fill Wizard help you create new fills. Answer the questions and the 
new Fill will be added to the bottom of the Fill Bar.

Use the Fill dialog box
Use the Fill dialog box, accessed from Format/Fill to apply existing Fills or create new ones.



Customize DrawPlus
General
Use the General tab of Tools/Options to set AutoSave times, undo levels and Fast Graduated Fill 
options.

Layout
Use the Layout tab of Tools/Options to change horizontal and vertical measurement units.

Ease of Use
Use the Ease of Use tab of Tools/Options to customize or reset helpful features.

Snapping
Use the Snapping tab of Tools/Options to set spacing for the snapping grid and to control other 
snapping options.



Microsoft Office Compatible
Serif DrawPlus 3.0 is a Microsoft Office Compatible product, which means that its toolbars, menus, and
shortcut keys are similar to those used by Microsoft Office. If you are already using Microsoft Office, 
which includes Microsoft Excel, Word, Microsoft Access and PowerPoint, then many of the tasks you 
have learned to complete in Office can be completed in a similar manner in DrawPlus 3.0. These 
similarities will make it easier for you to use our products together and with other Microsoft Office 
Compatible products.

Look for the Microsoft Office Compatible logo when purchasing software. For more information about 
the Microsoft Office Compatible program, and for a complete listing of Microsoft Office Compatible 
products, in the United States call Microsoft Customer Service at 1-800-426-9400. Customers outside 
the United States should contact their local Microsoft office.

Office Compatible Features of Serif DrawPlus 3.0
Includes the standard Microsoft Office menus: File, Edit, View, Insert, Format, and Tools menus. 

Has toolbars like those in Microsoft Office. You can customize the toolbars by choosing large or 
small and color or black-and-white buttons.

Include Wizards to simplify document creation and other complicated tasks.

Lets you send a DrawPlus 3.0 document through Microsoft Mail. If you have Microsoft Mail or 
Microsoft Exchange set up, you will see the Send item on the File menu.

Displays a context-sensitive menu when you click the right mouse button.

Displays a status bar at the bottom of the DrawPlus 3.0 to keep you informed as you work. Holding 
the mouse cursor over any    button shows a ToolTip describing the buttons purpose.

Using DrawPlus 3.0 with other Office applications

To embed a DrawPlus 3.0 Object in Microsoft Word:

In Word, select Object… from the Insert Menu. Select Serif DrawPlus 3.0 Drawing. DrawPlus 3.0 
will run In-place. Create your drawing as usual. To return back to Word, click on the Word page.

Drag and Drop between DrawPlus 3.0 and Word:

Make sure Word is running. In DrawPlus 3.0, select the object. Drag the object to the Word button 
on the taskbar, but do not drop it there. After a moment, the Word window opens. Drop the object 
on the open Word window.



Microsoft Office Compatible

Serif DrawPlus Home/Office 95 is a Microsoft Office Compatible product, which means that its toolbars, menus, 
and shortcut keys are similar to those used by Microsoft Office. If you are already using Microsoft Office, which 
includes Microsoft Excel, Word, Microsoft Access and PowerPoint, then many of the tasks you have learned to 
complete in Office can be completed in a similar manner in DrawPlus Home/Office 95. These similarities will make 
it easier for you to use our products together and with other Microsoft Office Compatible products.

Look for the Microsoft Office Compatible logo when purchasing software. For more information about the 
Microsoft Office Compatible program, and for a complete listing of Microsoft Office Compatible products, in the 
United States call Microsoft Customer Service at 1-800-426-9400. Customers outside the United States should 
contact their local Microsoft office.

Office Compatible Features of Serif DrawPlus Home/Office 95

Includes the standard Microsoft Office menus: File, Edit, View, Insert, Format, and Tools menus. 

Include Wizards to simplify document creation and other complicated tasks.

Has toolbars like those in Microsoft Office. You can customize the toolbars by choosing large or small and 
color or black-and-white buttons.

Displays a context-sensitive menu when you click the right mouse button.

Displays a status bar at the bottom of the DrawPlus Home/Office 95 to keep you informed as you work. 
Holding the mouse cursor over any    button shows a ToolTip describing the buttons purpose.

Lets you send a DrawPlus Home/Office 95 document through Microsoft Mail. If you have Microsoft Mail 
or Microsoft Exchange set up, you will see the Send item on the File menu.

Acts as both an OLE client and an OLE server. 

Using DrawPlus Home/Office 95 with other Office applications

To embed a DrawPlus Object in Microsoft Word:

In Word, select Object… from the Insert Menu. Select Serif DrawPlus Drawing. DrawPlus will run In-
place. Create your drawing as usual. To return back to Word, click on the Word page.

Drag and Drop between DrawPlus and Word:

Make sure Word is running. In DrawPlus, select the object. Drag the object to the Word button on the 
taskbar, but do not drop it there. After a moment, the Word window opens. Drop the object on the open 
Word window.

To embed a block of text from a Word document into a Serif DrawPlus document

In Word, select the text. Press CTRL+C to copy the text to the Clipboard. Switch to Serif DrawPlus. Press 
CTRL+V to paste the object into DrawPlus as an embedded Word object.




